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• Licensing Information, on page iii

Licensing Information
• Third-Party License and Notices (including free and open-source software)
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C H A P T E R 1
Overview of Cisco Webex Meetings

• Feature Highlights, on page 1
• Modern View and Classic View, on page 2
• Video-Centric Experience for Meetings, on page 2
• Account Types, on page 6
• Request a Host Account, on page 6
• Set Your Instant Meeting Preferences, on page 7
• Edit Your Profile, on page 7
• Change Your Avatar in Classic View, on page 8

Feature Highlights
With Cisco Webex Meetings, you can collaborate more efficiently with your contacts and colleagues. Here
are some highlights of what you can do:

• Host meetings in your dedicated Personal Room.

• Select Meet Now to start an instant meeting.

• Select Schedule to schedule a meeting.

• Join a meeting from your invitation email message or from the Meetings page on your Webex site.

• Select Recordings to find a meeting recording.

• Schedule, start, and join meetings from Microsoft Outlook using the Cisco Webex Meetings desktop
app, without signing in to your Webex site.

To download the Cisco Webex Meetings desktop app, sign in to your Webex site and select Downloads.

To ensure the best possible meetings experience, download the latest release of Java software for your
favorite web browser. For further assistance, contact your administrator.

• To download the Cisco Webex Meetings mobile app, visit the App Store for iOS or the Google Play
Store or Amazon Appstore for Android.
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CiscoWebexMeetings Server supports all WebexMeetings mobile app features,
unless otherwise noted. For information about Webex Meetings mobile app
features, see Explore the Webex Meetings Mobile App for iOS and Android.

Attention

For more information about the mobile app, see Cisco Webex Meetings Mobile App Resources.

• When you are away from your computer, you can schedule, start, and join meetings on your Apple or
Android mobile device.

• Join PCN and Blast Dial meetings at the touch of a button using your Apple or Android mobile device.
Optionally, you can join a web conference.

You must enable cookies in your browser. You cannot sign in to your Webex site if your browser settings
don't allow cookies.

Note

Modern View and Classic View
You can use your Webex site in Modern View or Classic View. Modern View, which provides you with a
personal dashboard, is the default view. You can start Webex Personal Room meetings, join upcoming
meetings, and schedule new meetings.

Modern View

To switch to Classic View from Modern View, select Classic View next to your name, at the top of the page.

Classic View

To switch to Modern View from Classic View, select Modern View next to your name, at the top of the page.

Video-Centric Experience for Meetings
We’ve made your meetings more engaging bymaximizing the space for video collaboration.Meet face-to-face
and see colleagues’ expressions as if you’re sitting at the same table.
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Figure 1: Video Centric Layout

You also have more control of who and what you see using new video and video + sharing layouts. Lock
focus on one person, keep content and video views side-by-side, or move panels to another monitor. Choose
what works best for you.
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Figure 2: Video Layouts

Figure 3: Share Content
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Figure 4: Video + Share Content

We’ve also centralized the essential meeting controls, like Mute, Share, or Record. The controls hide when
you’re not using them. Just move your cursor to make them reappear.
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Figure 5: Meeting Controls

Account Types
You can have one of the following account types on Cisco Webex Meetings Server:

• Attendee Only: You can attend meetings, but not start or host meetings. Because this account does not
have host privileges, you cannot be an alternate host.

• Host: You can schedule, start, and host meetings. You can also be an alternate host for another host's
meeting.

Request a Host Account
If you need host privileges so that you can schedule and host meetings, you can send a request to the system
administrator.
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Procedure

Step 1 Sign in to your Webex site, and then select Classic View.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 Select My Account in the top right corner.
Step 3 Go to the Meeting Host Privileges section.
Step 4 Select the Send a Request link.

You will receive an email notification that the system has received your request. You will get another email
after processing for your request is complete.

Set Your Instant Meeting Preferences
An instant meeting is a meeting that you can start right away without scheduling in advance. Complete this
task to set your default instant meeting preferences.

Procedure

Step 1 Sign in to your Webex site, and then select Classic View.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 Select My Account in the top right corner.
Step 3 Navigate to the Meet Now Settings section.
Step 4 Enter the requested information.

If you enter a password, the system requires attendees to enter this password whenever they join
your instant meetings.

Note

Step 5 Select Update.

Edit Your Profile
Do you prefer to use the short form of your name, or maybe your middle name? No problem, you can change
how your name appears in your profile. You can also personalize your profile by adding a profile picture.
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Procedure

Step 1 Sign in to your Webex site and mouse-over the down arrow beside your name.

If you use Classic View, select My Account.Tip

Step 2 From the list, select My Profile.
Step 3 To change only your profile picture, mouse-over it and select Change, then select Upload Picture.
Step 4 To edit your profile, select Edit My Profile.
Step 5 On the Edit My Webex Profile page, enter your First name and Last name as you want them to appear.

You can also change your profile picture on this page. Select Change profile picture and upload
a new image.

Tip

Step 6 Select Save.

Change Your Avatar in Classic View
By default, an image with your initials appears on your My Account page and in the Meeting Client. If your
administrator enabled this feature, you can change your avatar (profile picture).

User Guide for Cisco Webex Meetings Server Release 4.0
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Procedure

Step 1 Sign in to your Webex site, and then select Classic View.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 Select My Account in the top right corner.
Step 3 Click the Upload link.

If you want to remove an avatar without uploading a new image, click the Remove link. Your avatar changes
back to the default image with your initials.

Step 4 Browse to, and then select the image file that you want to use as your avatar.

The supported file types are PNG, JPG, JPEG, and GIF. The minimum dimensions are 160 by 160 pixels and
the maximum file size is 5 MB.

If you upload an animated GIF file, the system displays only the first frame.Note

Step 5 (Optional) Use the Zoom buttons to zoom in or out, and use the mouse to reposition the image.
Step 6 Click Upload to finish updating your avatar.
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C H A P T E R 2
Select Your Audio and Meet Now Options

• Webex Audio Settings, on page 11
• Audio and Video Connection Type, on page 12
• Change the Enter and Exit Tones for Your Meetings, on page 12
• Personal Conferencing, on page 13
• Create Your Personal Conference Account, on page 15
• Dial in to a Personal Conference Meeting, on page 15
• Regenerate Access Codes, on page 16
• Delete a Personal Conference Account, on page 17

Webex Audio Settings
Before you schedule or start your first meeting, sign in to your Webex site and configure your audio settings.
These settings determine the default options for all your scheduled meetings. You can change your default
settings when you schedule a meeting.

Classic View—Go to My Account > My Audio Connection Options.

Modern View—Go to Preferences > Audio.

Tip

Webex Audio lets you use either your phone or your computer to hear others and to speak in your meeting:

• Phone—You can use your phone to receive a call to the audio portion of the meeting or you can dial in.

• Computer—You can use a headset to join the audio portion of the meeting.

After they join the conference, participants can switch between audio modes with little or no listening
interruption. In a mixed-mode conference, where some participants use the phone and others use the computer,
all participants can speak.

Your role in an audio conference determines which audio management tasks you can perform.
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Task DescriptionRole in Audio Conference

• Join or leave the audio conference.

• Switch audio connection modes.

• Mute or unmute one or more microphones.

• Edit or update phone numbers in your user
profile.

Host an audio conference.

• Join or leave the audio conference.

• Switch audio connection modes.

• Mute or unmute your microphone.

• Edit or update phone numbers in your user
profile.

Participate in an audio conference.

Audio and Video Connection Type
When you start or join a meeting that uses Webex Audio, you can choose your connection method when the
Audio and Video Connection dialog box opens. For more information, see Connect to Audio and Video in
Cisco Webex Meetings.

Cisco Webex Meetings Server does not support the Call My Video System option.Note

Change the Enter and Exit Tones for Your Meetings

You must have a Host account to set options for meetings.Note

Procedure

Step 1 Sign in to your Webex site, and then select Preferences.

If you're using Classic View, select My Account.

If you have sign-in issues, ensure that your browser settings allow cookies. You cannot sign in
to Cisco Webex if your browser does not accept cookies.

Note

Step 2 On the Preferences page, select Audio.
Step 3 From the Entry and exit tone menu, choose from the following options:
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• Beep

• Announce Name

• No Tone

Step 4 Select Save.

Select Save before you leave the Audio Connection page. Otherwise, the system doesn't save
your changes.

Note

Personal Conferencing

You must have a Host account to host Personal Conference meetings.Note

With Personal Conferencing audio connection mode, meeting hosts can quickly start the audio portion of a
Cisco Webex meeting. The meeting host and participants simply dial the same call-in number, enter access
codes, and the audio portion of the meeting begins. The system then sends an email to the meeting host with
a link to the online portion of the meeting. If the host chooses to start the online meeting, participants can then
use it to share information or to collaborate on an idea. Personal Conference meetings do not require advanced
scheduling. Generated access codes do not change.

Personal Conference meetings are available, only if your site supports Personal Conferencing. Before you
can have a Personal Conference meeting, you must create a Personal Conference account and host PIN. You
can dial in to a Personal Conference meeting using either your phone or your computer.

• Phone—Use the call-in numbers. To view the call-in numbers on the My Accounts page, go to the My
Audio Connection Options section and selectPersonal Conferencing. If the host scheduled the meeting,
the email invitation that invitees receive includes the call-in numbers.

• Computer—Use a computer with a headset connected, to join the audio portion of a Personal Conference
meeting. When multiple participants plan to dial in to a meeting using a computer, we recommend that
the meeting host schedule the meeting in advance. Participants start and join the online portion of the
scheduled Personal Conference meeting by selecting the meeting link in their email invitation. After the
host and participants connect to the meeting, the Audio Conference dialog box opens and they can
connect to the audio portion of the meeting.

After joining the meeting, participants can switch between audio modes with little or no listening interruption.
In a mixed-mode conference, where some participants are using a phone and others are using a computer, all
participants can speak.

The number of people who can join a Personal Conferencemeeting depends on the configuration of the system.
Contact your administrator for more detailed information.

Note
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Your role in an audio conference determines your level of participation. The following table lists the basic
tasks a host and invitee can accomplish before and during a Personal Conference meeting.

TasksRole in Personal
Conference Meeting

Create a host PIN and Personal Conference account before starting or scheduling
your first Personal Conference meeting.

Schedule a Personal Conference meeting.

Dial a call-in number and enter their host access code and host PIN to start or
join a meeting.

Use the phone keypad functions:

• *5 lock and unlock a meeting.

• *6 mute or unmute self.

• *7 send a notification email to an invitee.

The system sends only one notification email message to
invitees, regardless of the number of times the host presses
*7.

Note

• *8 allow the meeting to continue without the host.

• ## mute all participants.

• 99 unmute all participants.

• *# play participant count.

• ** DTMF help.

After starting the online portion of a Personal Conference meeting, a host can:

• Pass the host role to another meeting participant.

• Reclaim the host role from a meeting participant.

• Record the meeting.

Host

Dial a call-in number and enter the participant access code to join a meeting.

Use the phone keypad functions:

• *6 to mute or unmute self.

• *# to play the participant count.

• ** for DTMF help.

After joining the online portion of a Personal Conference meeting, an invitee
can:

• Become a meeting host, if the host passes the host role.

• Pass the host role to another meeting participant.

Invitee

User Guide for Cisco Webex Meetings Server Release 4.0
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Your System Administrator can enable the Voice connection using computer option. When enabled, this
option disables keypad shortcuts for audio, when the web portion of a Personal Conference meeting starts.

Note

Create Your Personal Conference Account

You must have a Host account. Personal Conferencing is available only if the site Administrator enabled the
feature.

Note

To schedule or start Personal Conference meetings, create your host PIN and at least one Personal Conference
account. For each account, the system generates unique host and participant access codes. The system prompts
you for these codes after you dial a call-in number to start or join a Personal Conference meeting.

Procedure

Step 1 Sign in to your Webex site, and then select Preferences.

If you're using Classic View, select My Account.

Step 2 On the Meetings page, select Audio.
Step 3 Enter a 4-digit Host PIN and then select Generate an account.

The system creates and displays the host and attendee access codes for the new account. The access codes
remain the same until you regenerate the codes or delete the account.

You use the same host PIN for all accounts.Note

Step 4 (Optional) To create another account select Generate an account.

You can create up to three accounts.

While a Personal Conference meeting is in progress, you can't add a new account.Note

Dial in to a Personal Conference Meeting
The meeting host and participants dial the same call-in number and enter their host or participant access code.

For a Personal Conferencemeeting, always enter your access code if you receive a prompt to enter your access
code or meeting number.

Note
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Before you begin

• Your System Administrator must have enabled Personal Conferencing for your site.

• You must have a valid host PIN and at least one Personal Conference account.

Procedure

Step 1 Sign in to your Webex site, and then select Preferences.

If you're using Classic View, select My Account.

Step 2 Select Audio.

Your Host PIN, and the host and participant access codes for each of your personal conferencing accounts
appear.

Step 3 Provide the call-in number and participant access code to meeting participants.
Step 4 Dial the call-in number.
Step 5 If you're the host, enter your host access code and PIN; if you're a participant, enter your participant access

code.

Participants remain on hold until after the host dials the call-in number and enters the host access code and
PIN. After the host connects to the meeting, waiting participants automatically connect to the audio portion
of the meeting.

What to do next

If you are the meeting host, you can perform the following tasks:

• Start the online portion of the meeting to share information that meeting participants can view on their
desktops. You can start the meeting from the email invitation by selecting the meeting link, or by selecting
Start from the Meetings page.

• Press *8 on the phone before hanging up to allow meeting participants to continue the meeting without
a host.

If you simply hang up (without pressing *8 first) meeting participants can continue the meeting for five
minutes, after which, the meeting ends.

Anyone can leave the meeting by hanging up their phone or ending the call.

Regenerate Access Codes
For security purposes, you can regenerate access codes.

Regenerating access codes, invalidates the access codes for upcoming Personal Conference meetings. See
What to do Next .

Important
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Before you begin

You must have a Host account to host Personal Conference meetings and to regenerate access codes.

Procedure

Step 1 Sign in to your Webex site, and then select Preferences.

If you're using Classic View, select My Account.

Step 2 Select Audio.

The host and participant access codes for each of your personal conferencing accounts appear.

Step 3 Select Change to regenerate access codes for an account.

While a Personal Conference meeting is in progress, you cannot regenerate access codes.Note

What to do next

• Send the new access codes to all invitees who have the old access codes.

• Consider rescheduling previously scheduled Personal Conference meetings after you regenerate access
codes for an account. When you reschedule a meeting, invitees receive updated email invitations with
valid access codes.

Delete a Personal Conference Account
You can delete your Personal Conference accounts if you no longer need them.

Procedure

Step 1 Sign in to your Webex site and select Preferences.

If you're using Classic View, select My Account.

Step 2 Select Audio.

The host and participant access codes for each of your personal conferencing accounts appear.

Step 3 Select Delete for the account that you want to remove.

While a Personal Conference meeting is in progress, you cannot delete an account.Note
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What to do next

Consider rescheduling previously scheduled Personal Conferencemeetings after you delete an account.When
you reschedule a meeting, invitees receive updated email invitations with valid access codes.
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18

Select Your Audio and Meet Now Options
Delete a Personal Conference Account



C H A P T E R 3
Use the Webex Meetings Desktop App

• Install the Cisco Webex Meetings Desktop App—Classic View, on page 19
• Install the Cisco Webex Meetings Desktop App—Modern View, on page 20
• Set up the Cisco Webex Meetings Desktop App—Mac, on page 21
• Set up the Cisco Webex Meetings Desktop App—Windows, on page 21
• View Your Meeting List, on page 22
• Start a Meeting, on page 22
• Join a Meeting, on page 23
• Share Your Screen with a Video Device, on page 23
• Microsoft Outlook for Windows Integration, on page 25
• Update the Webex Meetings Desktop App, on page 29

Install the Cisco Webex Meetings Desktop App—Classic View
Use the Cisco Webex Meetings desktop app to easily start and join your meetings. With the Cisco Webex
Meetings desktop app, you can also add integrations to join meetings from other apps and to detect nearby
video devices.

Before you begin

If you have a previous version of the Cisco Webex Meetings desktop app, uninstall that version before you
install the new version.

Close web browsers and applications, such as Microsoft Outlook.

Procedure

Step 1 Sign in to your Webex site (Classic View).
Step 2 Select Download.
Step 3 Choose your operating system from the drop-down menu, and then select Download.

Windows: The webexapp.msi file downloads.

Mac: The webexapp.dmg file downloads.

Step 4 Run the installation file and follow the instructions.
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The Webex Meetings desktop app opens, after the installation is complete.

Step 5 Enter your Webex email address and select Next.
Step 6 Enter the URL for your Webex site and select Next.

After you successfully sign in to your Webex site, the Webex Meetings desktop app remembers the URL. If
you also sign in to cloud sites, you can select the URL for the Webex site that you want to use for meetings.

Step 7 Enter your Webex password, and then select Log in.

Install the Cisco Webex Meetings Desktop App—Modern View
Use the Cisco Webex Meetings desktop app to easily start and join your meetings. With the Cisco Webex
Meetings desktop app, you can also add integrations to join meetings from other apps and to detect nearby
video devices.

Before you begin

If you have a previous version of the Cisco Webex Meetings desktop app, uninstall that version before you
install the new version.

Close web browsers and applications, such as Microsoft Outlook.

Procedure

Step 1 Sign in to your Webex site (Modern View).
Step 2 Select Download from the navigation menu.
Step 3 Select Download for your operating system, and then select Save File.
Step 4 Choose the location, to which you want to save the file, and then select Save.

Windows—The webexapp.msi file downloads.

Mac—The webexapp.dmg file downloads.

Step 5 Run the installation file and follow the instructions.

The Webex Meetings desktop app opens, after the installation is complete.

Step 6 Enter your Webex email address and select Next.
Step 7 Enter the URL for your Webex site and select Next.

After you successfully sign in to your Webex site, the Webex Meetings desktop app remembers the URL. If
you also sign in to cloud sites, you can select the URL for the Webex site that you want to use for meetings.

Step 8 Enter your Webex password, and then select Log in.
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Set up the Cisco Webex Meetings Desktop App—Mac
Procedure

Step 1 On the app menu, select Cisco Webex Meetings.
Step 2 From the drop-down menu, select Preferences.
Step 3 In the navigation pane, select a category.

The Webex Meetings desktop app organizes your preferences into the following categories:

• General—Enable your app to appear on top of other windows and to open when you turn on your
computer.

• Account—Verify your username, Webex site URL, and the email address that you use in the app.

• Meetings—Choose your calendar and Meet Now settings.

• Notifications—Enable notifications for your meetings and choose when you receive them.

• Video Devices—Enable auto detect, to pair with nearby devices.

Step 4 Repeat Step 3 for each category that you want to change.
Step 5 To save your changes, select Save.

Set up the Cisco Webex Meetings Desktop App—Windows
Procedure

Step 1 In the top right corner of the Cisco Webex Meetings desktop app, select icon.
Step 2 From the drop-down menu, select Preferences.
Step 3 In the navigation pane, select a category.

The Webex Meetings desktop app organizes your preferences into the following categories:

• General—Enable your app to appear on top of other windows and to open when you turn on your
computer.

• Account—Verify your username, Webex site URL, and the email address that you use in the app.

• Meetings—Choose your calendar and Meet Now settings.

• Notifications—Enable notifications for your meetings and choose when you receive them.

• Video Devices—Enable auto detect, to pair with nearby devices.
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Step 4 Repeat Step 3 for each category that you want to change.
Step 5 To save your changes, select Save.

View Your Meeting List
You can easily check your upcoming meetings with the Webex Meetings desktop app.

Procedure

Step 1 Open the Webex Meetings desktop app.

Your list of meetings for the day appears in the Upcoming Meetings section.

Step 2 (Optional) To see your meetings list for another day, select , and then choose another date.

Start a Meeting
Procedure

Step 1 Open the Cisco Webex Meetings desktop app.
Step 2 Start your meeting.

• Select to start an unscheduled meeting.

If your system administrator enabled the feature, the meeting starts in your Personal Meeting Room.

• Select Start to start a previously scheduled meeting that you're hosting.

The Start button appears up to 15 minutes before your scheduled meetings.

You can change this setting by going to Preferences > Notification. You can choose to
have the Start button appear 5, 10, or 15 minutes before your scheduled meetings.

Note
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Join a Meeting
Procedure

Step 1 Sign in to the Webex Meetings desktop app.
Step 2 In the Join a Meeting field, enter the meeting details.

You can enter any of the following meeting details:

• Meeting number

• Meeting link

• Video address

• Host's Personal Room ID

You can find a host's Personal Room host ID in their Personal Room link. For example, if
the Personal Room link is example.webex.com/meet/jparker, the host's Personal Room ID
is jparker.

Note

In the Upcoming Meetings list, you can also select the Join button for a meeting.

The Join button appears up to 15 minutes before a scheduled meeting, depending on your meeting
notifications preferences.

Note

Share Your Screen with a Video Device
Use the Connect to a device option to share your screen wirelessly with an on-premises video device.

Procedure

Step 1 Select Connect to a device, and then choose the video device you want to use.
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Step 2 Select Share on Device.

User Guide for Cisco Webex Meetings Server Release 4.0
24

Use the Webex Meetings Desktop App
Share Your Screen with a Video Device



If you’re connected to an on-premises video device, you can share content on the device, even
when you’re not in a meeting.

Tip

Step 3 Select the content that you want to share.

Microsoft Outlook for Windows Integration

Microsoft Outlook integration applies only to Microsoft Outlook for Windows.Attention

The integration to Microsoft Outlook is part of the Cisco Webex Meetings desktop app, and gives you an
easy way to schedule, start, and join meetings from Microsoft Outlook.

Your site administrator may have installed the Cisco Webex Meetings desktop app for you. If not, you can
download it from your Webex site. See Install and Set Up the Cisco Webex Meetings Desktop App.

Meeting invitees aren't required to use Outlook to join meetings that you schedule in Outlook.
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Schedule a Meeting in Microsoft Outlook Using the Webex Meetings Desktop
App

Schedule a Meeting
Not all the features available for scheduling meetings on your Webex site are available in the Cisco Webex
Meetings desktop app. The integration to Microsoft Outlook does not support all the recurrence options that
are available in Microsoft Outlook.

In any meeting invitations that you send from Microsoft Outlook, the meeting start time appears in the time
zone that is set on your computer. Therefore, the meeting start time may not match the time zone preferences
that you set on your Webex site.

Procedure

Step 1 From the Home ribbon in Microsoft Outlook, select Schedule Meeting.
Step 2 In the drop-down list, choose from the following:

• Schedule Webex Meeting—Webex meetings are the standard meeting choice.
• Schedule Personal Conference Meeting—A Personal Conference meeting is an audio-only meeting
that's similar to a conference call. This meeting type can be escalated to a standard scheduled meeting,
if needed.

Step 3 Select To and choose who you want to invite to your meeting.
Step 4 Add a Subject and Location.
Step 5 Choose the Start time and End time for your meeting.

This includes the date, time, and duration of the meeting.

Step 6 Enter any other necessary information in the email invitation and select Send.

Edit a Scheduled Meeting
Once you schedule a meeting using the integration to Microsoft Outlook, you can use Microsoft Outlook to
edit it at any time. You can change the start time, specify a new password, choose a different audio connection
option, and more.

When you edit a scheduled meeting an updated email invitation is sent to the invitees and the meeting
information on your Webex site is updated.

Procedure

Step 1 On your Microsoft Outlook calendar, open the scheduled meeting item.
Step 2 Change any of the following settings:

• Change Settings–Change your Webex meeting settings.
• Recurrence–Add or change a recurrence pattern.
• To edit the text in your email invitation, type in the Appointment window.
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Step 3 Select Send Update.

Cancel a Scheduled Meeting
If you schedule a meeting using the integration toMicrosoft Outlook, you can cancel the meeting inMicrosoft
Outlook at any time.

• If you cancel a Webex meeting using your Webex site, your changes will not show inMicrosoft Outlook.

• If you cancel a single occurrence of a recurring Webex meeting using Microsoft Outlook, the changes
also show on your Webex site.

Note

Procedure

Step 1 On your Microsoft Outlook calendar, open the scheduled meeting item.
Step 2 Select Cancel Meeting.
Step 3 Select Yes in the confirmation message.
Step 4 Select Send Cancellation.

Recurrence Pattern Limitations
The following tables show the differences between Webex and Microsoft Outlook.

Table 1: Webex Meetings

Converted to Webex Meeting OptionMicrosoft Outlook OptionType

Every week on: [Sunday,Monday, Tuesday,Wednesday, Thursday, Friday, Saturday]Every [X] weeks on: [Sunday, Monday, Tuesday, Wednesday, Thursday, Friday,
Saturday]

Weekly

Not supportedThe [first, second, third, fourth, last] day not supported of every monthMonthly

Not supportedThe [first, second, third, fourth, last] weekday or weekend day

Not supported.[first, second, third, fourth, last] [day, weekday, weekend day] of
[January....December]

Yearly

Table 2: Webex Personal Conference Meetings

Converted to Webex Personal Conference Meeting OptionMicrosoft Outlook OptionType

Day [X] of every [y] monthDay [X] of every [y] monthMonthly

Not supportedThe [first, second, third, fourth, last] weekday or weekend day
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Converted to Webex Personal Conference Meeting OptionMicrosoft Outlook OptionType

Not supportedEvery [January....December] [1,....31]Yearly

Not supported[first, second, third, fourth, last] [day, weekday, weekend day] of
[January....December]

Not supported[first, second, third, fourth, last] [Sunday, Not supported. Monday, Tuesday,
Wednesday, Thursday, Friday, Saturday] of [January....December]

Not supportedNo end date.End date

Not supportedEnd after [x] occurrences.

Not supportedEnd by [date input]

Start a Meeting in Microsoft Outlook
You can start Cisco Webex meetings that you host, directly from Microsoft Outlook. Starting meetings from
Outlook can be faster because you don’t have to sign in to your Webex site.

Start a Scheduled Webex Meeting

Procedure

Step 1 From Microsoft Outlook, go to your calendar, and open your meeting invitation.
Step 2 Select Join Webex Meeting.

Start a Personal Conference Meeting

Procedure

Step 1 From Microsoft Outlook, go to your calendar, and open the meeting item.
Step 2 Dial the number provided.
Step 3 Follow the voice prompts and enter your host access code. If prompted, enter your PIN.

Start an Instant Meeting

Procedure

From Microsoft Outlook, on your toolbar, select Meet Now.
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If your administrator enabled Personal Rooms for your site, your instant meetings start in your
Personal Room. These meetings don't appear in the Upcoming Meetings list for you or for
invitees.

Note

Update the Webex Meetings Desktop App
You can update your Webex Meetings desktop app to ensure that you have the newest features and fixes.

Procedure

Step 1 Go to Settings.

• Windows: Select .

• Mac: On the app menu, select Cisco Webex Meetings.

Step 2 In the drop-down list, select Check for Updates.
Step 3 Follow the installation prompts.
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C H A P T E R 4
Use the Cisco Webex Meetings Desktop App as
a Guest

• Join a Cisco Webex Meeting for the First Time as a Guest , on page 31
• Use the Cisco Webex Meetings Desktop App as a Guest, on page 33

Join a Cisco Webex Meeting for the First Time as a Guest
Windows

1. When it's time to join the meeting, open your email invitation and select Join the Meeting.

2. Enter your name and email address, and then select Join Meeting.

The Cisco Webex Meetings desktop app installer downloads.

3. Double-click the executable (.exe) file to join your meeting.

4. Accept the Terms of Service and Privacy Statement.

The Webex meeting window loads and the Audio and Video Connection dialog box appears.

5. Connect your audio and video so other attendees can hear and see you.

6. When you want to leave the meeting, select Leave in the meeting controls, and then select Leave
Meeting.
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The Cisco Webex Meetings desktop app installs and opens on your desktop.

The app installs only if you don't already have the Cisco Webex Meetings desktop app or Cisco Webex
Productivity Tools installed.

You can use the Cisco Webex Meetings desktop app to join the next Webex meeting that you're invited
to. For more information, see Use the Cisco Webex Meetings Desktop App as a Guest.

User Guide for Cisco Webex Meetings Server Release 4.0
32

Use the Cisco Webex Meetings Desktop App as a Guest
Join a Cisco Webex Meeting for the First Time as a Guest

https://help.webex.com/x8p8cw/


Mac

1. Open your email invitations and select the Join link when it's time to join the meeting.

2. Enter your name and email address, and then select Join Meeting.

Select the Join Meeting list for more ways to join your meeting.

3. The Webex meeting window opens in a new browser window and the Audio and Video Connection
dialog box appears. Connect your audio and video so other attendees can hear and see you.

4. When you want to leave the meeting, select in the meeting controls, and then select Leave Meeting.

Use the Cisco Webex Meetings Desktop App as a Guest
The Cisco Webex Meetings desktop app allows you to join a Webex meeting as a guest, without signing in
to the app.

Procedure

Step 1 Open the Cisco Webex Meeting desktop app and click Use as guest.

Step 2 If required, enter your name and email address, and then click Continue.
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Windows: If you use Microsoft Outlook as your calendar and are signed in to your Microsoft account, the
Upcoming Meetings list shows meetings that are scheduled in your Outlook calendar.

Mac: The first time that you use the desktop app, click Import Outlook Meetings, and then sign in to your
Microsoft account to add your meetings to the desktop app.

Step 3 To join a meeting, do one of the following:

• In the Join a Meeting field, paste the meeting URL and then click Join.
• Click the Join button next the meeting name in the Upcoming Meetings list.

The Join button appears just before the meeting is scheduled to start.
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Step 4 Connect your audio and video so that other attendees can hear and see you.
Step 5 To join the meeting using a nearby video device; select Connect to a device and then select the device.
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C H A P T E R 5
Your Webex Personal Room

• Personal Room Benefits, on page 37
• Edit Your Personal Room Settings, on page 37

Personal Room Benefits
Your Webex Personal Room is your own virtual conference space that you can use for meetings at any time.
Your Personal Room is always available; you don’t have to book it, and you always know where to find it.

If you have back-to-back meetings, or need privacy in your Personal Room, you can lock it. When you lock
your Personal Room, no one can enter it until you unlock it or admit them. If you don't lock your Personal
Room, anyone who has your Personal Room URL can enter at any time.

If your administrator enables Personal Rooms for your site, all of your instant meetings start in your Personal
Room. You can still start Meet Now instant meetings from your Webex site, in Classic View.

Because Personal Room meetings don't require scheduling, they don't appear in the Upcoming Meetings list
for you, or for invitees.

Attention

Edit Your Personal Room Settings

Personal Room settings are available only in Modern View.Note

Procedure

Step 1 Sign in to your Webex site and go to Preferences > My Personal Room.
Step 2 (Optional) Edit your Personal Room name.

Your new name can be 1–128 characters.

Step 3 (Optional) Edit the unique ID portion of your Personal Room link.
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Your Personal Room link must meet the following criteria:

• 1–64 characters

• At least one alphabetical character

• No special characters, except hyphens (-), periods (.), and underscores (_)

• Not already in use by another account holder

Step 4 (Optional) To enable Automatic lock, check the corresponding checkbox and then select the number of
minutes to leave the room unlocked after a meeting starts.

If you set the number of minutes to 0, no one can enter your Personal Room until after you admit them.

Step 5 (Optional) To receive emailNotificationwhen someone enters your Personal Roomwhile you're away, check
the corresponding checkbox.

Step 6 Select Save.
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C H A P T E R 6
Join a Meeting

• Before You Join a Meeting, on page 39
• Join a Meeting from an Email, on page 40
• Join from the Meetings List in Modern View , on page 40
• Join from the Meetings Page in Classic View, on page 41
• Join a Meeting Using the Meeting Number, on page 41
• Join a Personal Room Meeting in Modern View, on page 42

Before You Join a Meeting
This section describes some of the things you might experience when you join a meeting.

When a meeting host schedules a meeting or starts an instant meeting by using the Meet Now option, the host
and all invitees receive an email invitation with the meetings details. When it's time to join a meeting, invitees
select the meeting URL in the email invitation or in an instant message.

The size of your system determines the maximum number of simultaneous users. If the number of users
reaches the maximum, you cannot join or start a meeting. If you dial in to a meeting, an audio message plays
to inform you that the system is at maximum capacity.

For any meeting, only half of the maximum number of participants can use video. Video is defined as sending
or receiving,by using your Webex webcam video or the video file share option.

If you see a prompt to install a Cisco Webex plug-in. Select Download and follow the instructions to install
the required plug-in. After installing the plug-in, some browsers require that you enable it. For more information
about how to enable plug-ins, see the documentation for your browser.

If the meeting does not start automatically, refresh the page.

If you use the Chrome browser to start a Webex meeting or to play a Webex recording, you might need to
add the Cisco Webex extension to your Chrome browser. This is a one-time installation.
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Join a Meeting from an Email
Procedure

Step 1 Open your email invitation, then select the link.

The meeting details page appears for the meeting you are joining.

Step 2 If requested, enter the required information.

Details that you may need to enter include the following:

• Your name: Enter the name you want attendees to use to identify you during the meeting.

• Email address: Enter your email address in this format: name@your_company. For example,
msmith@company.com.

• Meeting password: Enter the meeting password. The meeting host may have included the password in
the email invitation or, for security reasons, provided it to you in another way.

Step 3 Select Join.

• If you are already signed in or do not have an account on thisWebex site, wait for the meeting application
to launch.

• If you are not signed in but you do have an account on this Webex site, the system will redirect you to
a sign-in page where you can enter your user credentials before joining your meeting.

If your site is configured for single sign-on (SSO), the sign-in page is the company SSO
site. If your site is not configured for SSO, sign in through the Webex sign in page.

Note

What to do next

When the meeting window opens, the Audio and Video Connection dialog appears for you to select how
you want to connect.

Join from the Meetings List in Modern View
Procedure

PurposeCommand or Action

Sign in to your Webex site.Step 1

You can also click theMeetings link to see your
meetings list.

Locate your meeting in the Upcoming
Meetings tile.

Step 2

Select Join next to the meeting title.Step 3
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Join from the Meetings Page in Classic View
Procedure

Step 1 Sign in to your Webex site, and then click Classic View.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 Locate your meeting in the Today list.

If your meeting is not visible, select the All Meetings tab and enter your search parameters to locate it.

Step 3 Select Join.

When the meeting window opens, the Audio and Video Connection dialog appears and you can select how
you want to connect.

Join a Meeting Using the Meeting Number
You can join a meeting using the meeting number, even when you are not signed in to Cisco Webex.

Procedure

Complete the steps that correspond to your scenario, as described in the If column:

Do ThisIf

a. In the search bar, enter the meeting number and
select the green Join arrow.

b. Enter the meeting password, if requested.

c. Select Join Meeting.

You are already signed in to your Webex site in
Modern View

a. Ensure that you are on the Meetings page by
selecting the Meetings tab.

b. Select Join by Number.

c. Enter the meeting number.

d. Enter the meeting password, if requested.

e. Select Join.

You are already signed in to your Webex site in
Classic View
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Do ThisIf

a. Open your web browser and navigate to your
Webex site.

b. In the Join a Meeting field, enter the meeting
number or Personal Room ID, and then select
Join.

You are not signed in to your Webex site in Modern
View

a. Open your web browser and navigate to your
Webex site.

b. Select Join by Number.

c. On the Join by Number page, enter the requested
information.

d. Select Join.

You can also access the Join by
Number page by entering your public
Webex site URL followed by /orion/join.

Example: https://<public site

url>/orion/join

Tip

You are not signed in to your Webex site in Classic
View

Troubleshooting Tips

If you cannot join the meeting using the meeting number, try the following steps:

• Ensure that you are entering the correct meeting number.

• Ensure that it is the correct time to join the meeting.

• If your information is correct, search for the meeting on the Meetings page and try to join from the link.

Join a Personal Room Meeting in Modern View
You can join a meeting in someone's Personal Room from the Webex site in Modern View.

Procedure

Step 1 In the search bar, enter the host's Personal Room ID and then select Join arrow.

As you type, the search feature presents possible matches.

Step 2 Select the corresponding Join button.
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If the host has not joined the meeting or if the meeting is locked, you must wait in the lobby until
the host arrives. You can select Notify Host to send an email to the host to let them know you
are waiting.

Tip
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C H A P T E R 7
Start or Schedule a Meeting

• Schedule a Meeting from the Webex Site in Modern View, on page 45
• Schedule a Meeting from the Webex Site in Classic View, on page 46
• , on page 48
• , on page 48
• Allow Another Person to Schedule Meetings for You, on page 48
• Start a Meeting from the Webex Site in Modern View, on page 49
• Start a Meeting from the Webex Site in Classic View, on page 50
• Start an Instant Meeting in Modern View, on page 50
• Start an Instant Meeting in Classic View, on page 51
• Start a Personal Room Meeting in Modern View, on page 51
• Find a Meeting in Classic View, on page 52
• Find a Meeting in Modern View, on page 53
• Edit a Meeting, on page 53
• Edit a Recurring Meeting, on page 54
• Cancel a Meeting, on page 55
• Recurrence Pattern Support, on page 56

Schedule a Meeting from the Webex Site in Modern View
Procedure

Step 1 Sign in to your Webex site.

Step 2 Go to Meetings, and then select Schedule.

You can also select Schedule on your Home page.

Step 3 Select a Meeting type.
Step 4 Enter the Meeting topic.
Step 5 Select the Date and time, including the time zone.
Step 6 Set the meeting to recur by checking the Recurrence check box.
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You can schedule your meeting to happen weekly, biweekly, monthly, and more.

Step 7 In Attendees, enter the email address of each person you want to invite.

Predictive search suggests people you invited before, and existing accounts on your Webex site.

Step 8 (Optional) To make an attendee an alternate host, select .

This option is available only if the attendee has a host account on your site.

Step 9 (Optional) Select Show advanced options.
a) Select Audio connections options and choose your settings:

• Audio connection type

• Entry and exit tone

b) Select Scheduling Options and choose your settings:

• Automatically start recording when the meeting starts

• Exclude password from email invitation

Step 10 Select Schedule.

Schedule a Meeting from the Webex Site in Classic View
Before you begin

You must have a Host license to schedule or start a Webex meeting.

Procedure

Step 1 Sign in to your Webex site.
Step 2 If you're in Modern View, select Classic View.
Step 3 At the top of the Meetings page, select Schedule.

The Schedule a Webex Meeting page appears.

You can schedule a meeting on behalf of another host if that host has allowed you to do so in
their account preferences. Select the host from the Schedule for: drop-down list. A prompt
appears to confirm the transfer of host scheduling privileges for the meeting. Shared information
such as meeting topic, date, length, and recurrence remain the same. You can then continue
scheduling the meeting using the hosts' privileges.

Note

Step 4 Specify the following information for your meeting:

• What: What the meeting is about?
• When: When does the meeting take place?
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To schedule a recurring meeting, select Recurrence then choose your option.

• Length: How long is the meeting?
• Meeting Type: What type of meeting is it?

Set up by your administrator, the meeting type determines the various conferencing features and options
available for the meeting. For example, recording is not available for some meeting types.

• Who: Who do you want to invite to your meeting? You can type email addresses or type names to search
for in your contacts. You can also invite people later after you have scheduled the meeting.

If you want to allow an invitee to have most of the same hosting privileges as you do, select
the Alternate Host option for that invitee. Alternate hosts cannot edit or delete a meeting.
If you join the meeting after an alternate host starts it, you automatically become the host.

Note

If your organization uses single sign-on (SSO), you may get a message that the email address is not
found. This usually means that your administrator changed the email address of your alternate host. The
daily synchronization between Exchange, Outlook, and CWMS propagates new email addresses. Before
the synchronization occurs, you cannot designate alternate host who has new email addresses.

Step 5 Select your audio connection type.

You can change the audio options from the scheduling page, only by changing the meeting type.
A green checkmark indicates the available options. A red cross indicates unavailable options.
You cannot change the meeting type when using Meet Now to start a meeting.

Note

• Webex Audio - This audio connection mode lets meeting hosts and participants join the online portion
of the meeting using the link provided in the meeting email invitation message. Once connected to a
meeting, users can either call in to the meeting or use the Call Me feature to receive a call at a number
they have provided. This option requires a host to schedule a meeting with either the Meet Now feature
or the scheduler.

• Personal Conferencing - This audio connection mode lets a meeting host quickly start the audio portion
of a Cisco Webex meeting at any time. The meeting host and participants simply dial the same call-in
number, enter access codes, and the audio portion of the meeting begins. The system then sends an email
to the meeting host with a link to the online portion of the meeting. If the host chooses to start the online
meeting, participants can then use it to share information or collaborate on an idea. The meeting host is
not required to schedule Personal Conferencing meetings in advance, and once generated, the access
codes do not change.

You must have a Personal Conference account and a host PIN to use the Personal Conferencing
option.

Note

Step 6 (Optional) For a Webex meeting, enter a Meeting Password.

• Enter password if you want to make your meetings private. Your invitees must enter the meeting password
to join the meeting unless they signed in to their Webex account before joining.

• For extra security, check Exclude password from email invitation. Excluding the password means that
it is not displayed in the meeting details page or any email invitations. As the meeting host, you can then
choose to send the password specifically to your invitees and others who request it.

Step 7 (Optional) Select Record this meeting to have the system automatically start recording when the meeting
starts.
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If the host joins as a participant and then assumes the host role, the meeting does not start
automatically. In this case, the host must start the recording manually.

Note

Step 8 Select Schedule It!.

The meeting details page appears with a message confirming that your meeting is scheduled.

The maximum meeting length is 24 hours.Note

The system prevents you from scheduling a meeting during a scheduled maintenance window or
when a future maintenance window is scheduled.

Note

To schedule a meeting on behalf of someone else, that person must have allowed another host to schedule
meetings on their behalf.

When you schedule a meeting for another host, both you and the other host can modify the meeting.

Procedure

Step 1 Sign in to your Webex site.
Step 2 Select Schedule to go to the Schedule a Meeting page.
Step 3 In the Schedule for drop-down list, select the host's name for whom you're scheduling the meeting.

To see this option, the person for whom you're scheduling the meeting must have allowed another host to
schedule meetings on their behalf.

Step 4 Enter the details for the meeting.
Step 5 Select Schedule to schedule your meeting for later.

Allow Another Person to Schedule Meetings for You

Both you and the person who schedules meetings for you must have a Host account.Note

You can grant permission to one or more people to schedule meetings on your behalf. After someone else
schedules a meeting for you, the meeting appears in your list of meetings. You can start the meeting and host
it the same way that you do when you schedule meetings yourself.

This task assumes the following points about you and anyone who schedules meetings on your behalf:

• You both have accounts on your Webex site.

• You both have Host licenses.
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• To schedule meetings in Microsoft Outlook, you both have Outlook and the Webex Meetings desktop
app integration with Outlook installed.

Procedure

Step 1 Sign in to your Webex site.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 Go to the Scheduling Permission page.

For Modern View, go to Preferences > Scheduling > Scheduling Permission.

For Classic View, go to Classic View > My Account > Session Options > Scheduling Permission.

Step 3 Enter the email addresses of users who you permit to schedule meetings on your behalf.
Step 4 Select Save or Update.

Start a Meeting from the Webex Site in Modern View
Procedure

Step 1 If you're the host, sign in to your Webex site at the scheduled time.

In Modern View, the list of your upcoming meetings appears in the Upcoming Meetings tile.

Step 2 Locate your meeting and select Start to begin.
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Start a Meeting from the Webex Site in Classic View

You must have a Host account to schedule a meeting.Note

Procedure

Step 1 Sign in to your Webex site.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 Locate the meeting that you want to start.

The Start button is green only within the specified time to start the meeting.Tip

Step 3 Select Start.
Step 4 (Optional) If the meeting you are starting is part of a recurring series, confirm that you want to start the next

upcoming meeting in the series.

Start an Instant Meeting in Modern View
Use this procedure to start a Meet Now instant meeting. Essentially, you schedule the meeting and start it
right away, so Meet Now meetings appear in the meetings list for you and for invitees.

Procedure

Step 1 Sign in to your Webex site.
Step 2 Select Schedule on your Home page.
Step 3 Select a Meeting type.
Step 4 Enter the Meeting topic.
Step 5 Select the Date and time, including the time zone.
Step 6 In Attendees, enter the email address of each person you want to invite.

Predictive search suggests people you invited before, and existing accounts on your Webex site.

Step 7 (Optional) Select Show advanced options.
a) Select Audio connections options and choose your settings:

• Audio connection type

• Entry and exit tone
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b) Select Scheduling Options and choose your settings:

• Automatically start recording when the meeting starts

• Exclude password from email invitation

Step 8 Select Start.

Start an Instant Meeting in Classic View

You must have a Host account to schedule a meeting.Note

If you want to set a password for your instant meetings, select My Account and enter one in the Meet Now
Settings section. You can always change the password when you schedule a meeting. Meet Now settings do
not apply to Personal Room instant meetings.

Procedure

Step 1 Sign in to your Webex site.
Step 2 On the Meetings page, select Meet Now.
Step 3 (Optional) If you see the Meeting Password field, do the following:

• Check Show actual password if you want to see the password that you enter.

• For more security, check Exclude password from email invitation. If you exclude the password, it
doesn't appear on the meeting details page or in any email invitations. As the meeting host, you can then
choose to send the password specifically to your invitees and others who request it.

The password field appears only if you set a password in your account settings, and if your site
settings require a password for meetings.

Tip

Step 4 Select Start.

Start a Personal Room Meeting in Modern View
A Personal Room is your own virtual conference space. It’s always available and you never have to book it,
so it's great for instant meetings. Attendees can easily find your Personal Room by using your Personal Room
link, your email, or your phone number.
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If you're new to Personal Rooms, there are some differences for instant meetings.WithMeet Now, each instant
meeting has a new identifier. Your Personal Room ID doesn't change and therefore there's no need for
scheduling. When you invite and remind people from your Personal Room, the invitees receive the email
invitation. The meeting doesn't appear in the Meetings list page for you or for the invitees.

Note

Procedure

Step 1 Sign in to your Webex site.
Step 2 On your Home page, select Start Meeting.

You can send the Personal Room URL to the participants in a message. You can find your Personal Room
URL on your Home page. During a meeting, you can go to Meeting Controls > More Options > Copy
Meeting Link on your Webex site.

Find a Meeting in Classic View
Procedure

Step 1 Sign in to your Webex site (Classic View).

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 Select the All Meetings tab.

By default, the All Meetings page displays up to 50 meetings, for which you are the host. This list includes
meetings that are in-progress, or upcoming; and meetings past the scheduled start time and not started.

If you have an Attendee Only account, you see only a list of meetings to which you are invited.

In Classic View, after a meeting starts and ends, the system removes it from the Meetings page.

Step 3 Enter your search parameters and then select Search.

The meeting list updates with your search results.
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Find a Meeting in Modern View
Procedure

Step 1 Sign in to your Webex site.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if your browser does not allow cookies.

Note

In the Upcoming Meetings section, you can see upcoming meetings. If you're the host, you can select Start
whenever you're ready to start your meeting.

Step 2 If you don't see the meeting you're looking for, you can search for it; just enter your search string in the search
bar.

Step 3 (Optional) To find a specific meeting within a specified range of dates, select Meetings from the navigation
menu.

Edit a Meeting
This task describes how to edit a single meeting. To edit a recurring meeting, see Edit a Recurring Meeting,
on page 54.

You must have a Host account to schedule and edit meetings.Note

Procedure

Step 1 Sign in to your Webex site.

If you have sign-in issues, ensure that cookies are enabled in your browser.

Step 2 Go to Meetings.

For Classic View, select Classic View > All Meetings.

Step 3 In the Meetings list, locate and select the meeting that you want to edit.
Step 4 (Optional) Specify an alternate host.

a) In the Who is Invited? section, locate the attendee to designate as an alternate host and mouse-over

.
b) Select Assign alternate host.
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Step 5 To change the meeting settings, select Edit.
Step 6 Change the meeting settings and then select Save.

Edit a Recurring Meeting

If you originally scheduled your meeting with Microsoft Outlook, edit your meeting in Outlook to keep the
meeting information your Outlook calendar up-to-date.

Tip

You must have a Host account to schedule and edit meetings.Note

Procedure

Step 1 Sign in to your Webex site.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 Go to Preferences > Scheduling > Scheduling Permission.

For Classic View, click Classic View > My Account > Session Options > Scheduling Permission.

Step 3 Select the topic of the meeting that you want to edit.

The meeting details page appears.

Step 4 Select Edit.
Step 5 Select whether you want to edit a single occurrence of this meeting series or the entire series.
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If you make changes to a single occurrence of a meeting series, the system assigns a newmeeting
ID for that occurrence. Because the original meeting ID and link are still valid, the result is in
two separate meeting rooms becoming available for the meeting. If invitees join using the original
Join Meeting meeting information, they cannot see or be seen by invitees who joined using the
updated meeting link. It is very important that you send an updated meeting notification, with
the new meeting ID and link, to all your invitees.

If you delete a meeting occurrence from a series, and later edit the entire meeting series, the
system restores the deleted single meeting occurrence to the meeting list.

Note

Step 6 Modify the meeting parameters.
Step 7 Save your changes.

For Modern View, select Save.

For Classic View, select a save option:

• Save and Notify All—Saves your updates and sends an updated meeting notification to all invitees.
• Save Only—Saves your updates but does not send an updated meeting notification to your invitees.
• Save and Notify Updated Invites—Saves your updates and sends an updated meeting notification to
newly added invitees only.

Cancel a Meeting
You can cancel any meeting that you have scheduled from the meeting details page. When you cancel a
meeting, the system deletes it from the list of meetings on the Meetings page.

If you originally scheduled the meeting with Microsoft Outlook, remember to cancel the meeting in Outlook
as well.

Tip

You must have a Host account to schedule or cancel meetings.Note

Procedure

Step 1 Sign in to your Webex site.

If you have sign-in issues, ensure that cookies are enabled in your browser. You cannot sign in
to Cisco Webex if cookies are disabled.

Note

Step 2 View your list of meetings.

For Modern View, select Meetings.

For Classic View, select Classic View, and then select the All Meetings tab.
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Step 3 Open the meeting details page by selecting the topic for the meeting, or by selecting the link from your
confirmation email message.

Step 4 Click Cancel or Delete and then confirm when the dialog appears.
Step 5 If the meeting is part of a recurring series, choose whether you want to delete this occurrence only or the entire

meeting series.
Step 6 In Classic View, choose whether to send a cancellation email message to all invited attendees and then select

OK

Recurrence Pattern Support
You can set up a recurring meeting, such as a monthly company meeting or a weekly status meeting. When
you schedule a recurring meeting, you set up the meeting once for instances of the meeting.

If you schedule recurring back-to-back 24-hour meetings, ensure that each meeting ends before the scheduled
start time for the next meeting.

If a meeting in the series does not end before the scheduled start of the next meeting, the system deletes the
next meeting occurrence. This issue occurs because the system does not actually schedule the next meeting
in the series until the current meeting ends.

Important

You must have a Host account to schedule meetings or modify settings for them.Note

Table 3: Supported Recurrence Patterns

DescriptionType

Repeats the meeting every day until the ending date
that you select.

• Every [x] days—Specifies the number of days
between meeting instances.

• Every weekday—Repeats themeeting each day,
from Monday to Friday.

Daily

Repeats the meeting every week until the ending date
that you select.

Every [x] week(s) on—Specifies a day of the week,
and the number of weeks between meeting instances.

Weekly
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DescriptionType

Repeats the meeting everymonth until the ending date
that you select.

• Day [x] of every [x] months—Specifies the
specific day of the month on which to repeat the
meeting, and the number of months between
meeting instances.

• Every [x] of the [x] week of every [x]
month(s)—Specifies the specific day of the
week, the specific week of the month, and the
number of months between meeting instances.

Monthly

• No end—Repeats the meeting for 10 years.

• End by—Specifies the last day on which the
meeting recurs.

• After [x] meetings—Specifies the number in
the meeting series after which the meeting stops
recurring.

Ending
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C H A P T E R 8
Mobile Devices

• Downloads for Mobile Devices, on page 59
• Sign in to Webex Using a Mobile Device, on page 59
• Schedule a Meeting with a Mobile Device, on page 60
• Start a Meeting with a Mobile Device, on page 60
• Join a Meeting with a Mobile Device, on page 61
• Install an SSL Certificate on an iOS Mobile Device, on page 61

Downloads for Mobile Devices
You can download the Cisco Webex Meetings desktop app from your Webex site.

• For Modern View, go to Download > Mobile App > App Store or Google Play.

• For Classic View, go to Classic View > Download > Webex for Mobile Devices > Continue.

You receive an activation email, with instructions and links to the App Store or Google Play.

Your administrator must configure the system to display the option to download Webex for mobile devices
before you can see it on your Webex site.

Note

Sign in to Webex Using a Mobile Device
There are several ways to sign in to Webex, depending on the system settings. The application guides you
through the sign-in process, but here are a few tips:

• If you get an email that asks you to activate your Webex app, select the link to activate your service.
Enter the email address associated with your Webex account and your Webex password to sign in.

• If the system prompts you to sign in through your corporate website, enter your Webex site URL, and
then select Next. Enter your corporate user credentials to sign in.
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If yourWebex site uses single sign-on (SSO), ensure that you enter your corporate
user credentials to sign in. If your Webex site doesn't use SSO, enter your Webex
user credentials.

Tip

• If you have access to multiple Webex sites, the system prompts you to choose one, after you sign in.

• To join a Webex meeting, open the meeting invite in your email inbox or from your Calendar app. Tap
on the meeting link to launchWebex in your web browser. If the meeting requires a password, the system
prompts you to enter the meeting password. After you provide your password, you join the meeting.

If you're not signed in to theWebex app, you can't join by meeting number unless
you previously signed in from your mobile device.

Tip

Schedule a Meeting with a Mobile Device
As a host, you can use your mobile device to schedule Webex meetings and invite others to join.

Procedure

Step 1 Open the Webex meetings application, and then swipe right to go to the My Meetings screen.
Step 2 Select the + icon in the upper right corner of the screen.

The Schedule Meeting screen appears.

Step 3 Enter your meeting title, date and time, and then select your desired attendees.
Step 4 Tap Schedule.

You return to the My Meetings screen.

Start a Meeting with a Mobile Device
As a host, you can use your mobile device to start a scheduled meeting or an instant meeting.

Procedure

Step 1 Open the Webex Meetings application.
Step 2 Start your meeting:

Do ThisMeeting Type

Swipe right to go to the My Meetings screen. Locate
your meeting, and then tap Start.

Scheduled Meeting
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Do ThisMeeting Type

Tap Start Meeting.Instant Meeting

Join a Meeting with a Mobile Device
Ensure that you have the Cisco Webex Meetings app installed on your mobile device. You can join your
Webex meeting using one of the following methods:

• Open your Webex meeting invitation, and then select the meeting link.

• Sign in to your Webex account, and then join from the My Meetings page.

• Sign in to your Webex account, tap Join Meeting, and then enter the meeting number.

Install an SSL Certificate on an iOS Mobile Device
Before you join a Webex meeting, install an SSL certificate on your mobile device, if either of the following
conditions is true:

• Your Webex site uses a self-signed certificate.

• The root certificate installed on your Apple iPhone or iPad isn't on the Apple trusted Certificate Authority
list.

Before you begin

An administrator must send you a certificate file attached to an email message.

You must have an active high-speed Internet connection for your mobile device.

Procedure

Step 1 From your iOS email account, open the email from your administrator and save the certificate file to your
mobile device.

Step 2 Install the certificate on your mobile device.
a) Tap Install on the Install Profile page.
b) Tap Install Now on the Unsigned Profile dialog.
c) Enter the certificate password.
d) Tap Next.
e) Tap Done.
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C H A P T E R 9
Start or Join a Blast Dial Meeting

• Request to Set Up a Blast Dial Group, on page 63
• Start a Blast Dial Meeting, on page 64
• Join a Blast Dial Meeting, on page 65
• Audio Key Shortcuts, on page 66

Request to Set Up a Blast Dial Group
With the Blast Dial feature, hosts can quickly and easily start a meeting with a predetermined group of people.
To get started, download and complete the templates, and then submit them to your system administrator.

Perform this procedure only if you have a host account, and you are the designated host for the new Blast
Dial group.

Important

Procedure

Step 1 Sign in to your Webex site, and then select Classic View.
Step 2 Select the My Account link.
Step 3 In the Blast Dial Information section, select the GroupTemplate link and download the template.

• You can leave the Route Pattern and Call-in Number fields blank. Your administrator
configures a route pattern and call-in number for each Blast Dial group.

• If you plan to start the online portion of your Blast Dial meeting, consider entering a meeting
password to provide extra security for your meeting.

• If you have a large Blast Dial group, consider selecting No Tone for the joining meeting
Indicator to provide the best meeting experience.

• If it is imperative for all participants to join your Blast Dial meeting, you can enable the
Unlimited Call Attempts.

• For the most secure meeting, consider having a 10-digit host PIN and participant PIN.

Tip
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Step 4 Select the ParticipantsTemplate link and download the template.

• For internal participants, meaning users who have a company email address, you can provide
only their email address.

• To give host privileges for the Blast Dial meetings to an internal participant, enter a 'Y' in
the ISHOST column.

• Designate at least one internal participant as host, for each Blast Dial group.

• For external participants, enter a first and last name, an email address, and up to four phone
numbers. If you do not provide a phone number for an external participant, the system doesn't
call this participant when a Blast Dial meeting starts. To join, the participant must call into
the meeting by dialing the call-in number and entering their participant PIN.

Tip

Step 5 Follow the instructions, provided at the top of each template, to fill in the required information.
Step 6 Send the completed templates to the administrator, who creates the Blast Dial group.

Hosts receive an email notificationwith the Call-in number and host PIN (if configured) when the Administrator
creates a Blast Dial group.

Participants receive an email notification with the Call-in number, participant PIN (if configured) when the
Administrator creates a Blast Dial group.

Start a Blast Dial Meeting
Use this feature to quickly start a meeting with a preconfigured group of users. If you are a Blast Dial host,
you can start a Blast Dial meeting anytime. After you call the Call-in access number and enter your host PIN,
the system automatically begins calling the members from the Participants list.

See the Blast Dial Information section on your My Account page. The page displays the Call-in number and
PIN information for each Blast Dial group, for which you are a host or a participant. As host, you can call in
to an in-progress Blast Dial meeting and enter either a host PIN or participant PIN to join the meeting.

Safeguard your host PIN. Anyone who knows the call-in number and host PIN can start or join a Blast Dial
meeting.

Important

For Blast Dial online meetings, the host cannot edit or delete the online portion of the meeting and participants
cannot join the meeting before the host.

Note

For audio only Blast Dial meetings, the meeting ends when the last person in the meeting ends the call. For
online Blast Dial meetings, the meeting ends when the host ends the online portion of the meeting.

Before you begin

Request to Set Up a Blast Dial Group, on page 63
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Procedure

Step 1 A host calls the Call-in number indicated in your email notification or My Accounts page.
Step 2 Enter the host PIN.

The meeting starts immediately and the system automatically calls the list of participants. The system also
sends an email notification with the URL for the web portion of the meeting.

If a Blast Dial group includes multiple hosts, the first to join and enter the host PIN is the meeting
host. The other hosts join the meeting by answering the system-generated Blast Dial call and
enter the host PIN.

Note

Step 3 (Optional) Start the online portion of the meeting by selecting the URL in your email notification.

Any Blast Dial host can start the online portion of the meeting.Note

Step 4 (Optional) Enter a meeting password, if required, when you access the online portion of the meeting. This
password is provided in your email notification.

Join a Blast Dial Meeting
You receive an email when the Administrator adds you to the Participants list for a Blast Dial group. This
email includes the call-in number, participant PIN (if necessary), and meeting password (if necessary). Your
My Account page lists the information for each Blast Dial group, for which you are host or participant.

The system calls participants to join a Blast Dial meeting. If participants miss the call or they want to join an
in-progress Blast Dial meeting, they dial the call-in number and enter the participant PIN.

Safeguard your host PIN. Anyone who knows the call-in number and host PIN can start or join a Blast Dial
meeting. Likewise, anyone who knows the call-in number and participant PIN can join an in-progress Blast
Dial meeting.

Important

For audio only Blast Dial meetings, the meeting ends when the last person in the meeting ends the call. For
online Blast Dial meetings, the meeting ends when the host ends the online portion of the meeting.

Procedure

Step 1 When you answer a Blast Dial call, enter the participant PIN to join the meeting.

If you are a host but did not start the meeting, enter either the host PIN or participant PIN to join the meeting.

You connect to the audio portion of the meeting.
Step 2 (Optional) To join the online portion of the meeting, select the URL indicated in your email notification.

A host must start the online portion of the meeting before you can join it.Note

Step 3 (Optional) Enter a meeting password, if necessary.
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Audio Key Shortcuts
During the audio portion of a Blast Dial meeting you can enter the following audio key shortcuts on the keypad
of your phone or mobile device:

• *3 Remove yourself from this Blast Dial list

• *5 Lock or unlock (host only)

• *6 mute self or unmute self

• ## Mute all participants (host only)

• 99 Unmute all participants (host only)

• *# Play participant count

• #7 End meeting (host only)

• ** DMTF help

The audio key shortcuts are only available during the audio portion of the Blast Dial meeting. After the host
starts the online portion of the meeting, you can use the meeting client.

Note
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C H A P T E R 10
Manage Meeting Recordings

• Find a Meeting Recording, on page 67
• Play a Meeting Recording, on page 68
• Download a Meeting Recording or the Webex Network Recording Player, on page 68
• Share a Meeting Recording, on page 69
• Delete Meeting Recordings, on page 69

Find a Meeting Recording
Meetings that you record on the server appear on the Meeting Recordings page.

Only meetings that you scheduled and recorded appear in the list. Meetings that you recorded as an alternate
host don't appear in the list.

If you need a link to the recording for a meeting that you didn't schedule, contact the meeting host.

Procedure

Step 1 Sign in to your Webex site, and then select Recordings.

If you have sign-in issues, ensure that your browser settings allow cookies.

Step 2 Select and enter a search string.

You can search for the meeting name, the meeting description, or for the full name of the recording owner.

Step 3 When you find the recording, select the corresponding Play button.
The recording plays in a new window.
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Play a Meeting Recording
Procedure

Step 1 Sign in to your Webex site, and then select Recordings.

If you're using Classic View, select the Recordings tab.

If you have sign-in issues, ensure that your browser settings allow cookies.

Step 2 Select and enter a word or phrase to search.

To clear the search bar, select .

When you locate the recording, select the corresponding Play icon.

The recording plays in a new window.

Download a Meeting Recording or the Webex Network
Recording Player

Download a meeting recording to play it on your device, or to save it locally for future reference.

If you receive notification to preserve your meeting recordings, download the recordings to your local PC.Note

Procedure

Step 1 Sign in to your Webex site, and then select Recordings.

If you're using Classic View, you can select the Recordings tab.

If you have sign-in issues, ensure that you have cookies are enabled in your browser.

Step 2 Locate the meeting recording that you want to download and select the corresponding Download button.
Step 3 Choose where to save the file and select OK.
Step 4 To download the Network Recording Player, select Download Player.
Step 5 After you download a recording, double-click the recording file to start playback.
Step 6 (Optional) (For Windows Users) To convert a recording to Windows Media Video (WMV) or Adobe Flash

file (SWF), from theNetwork Recording Playerwindow select File >Convert Format and select the desired
format. Complete the fields on the Convert Format dialog.
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On the original recording (either streaming or downloaded), video and audio quality is good (24+ frames per
second). After converting the recording to WMV or SWF format, you might find that the audio and video
quality seems to be lower (5 frames per second).

The converted file appears in the location you specified in the Save As field. Double-click the .wmv or .swf
file to play the recording.

Share a Meeting Recording
Procedure

Step 1 Sign in to your Webex site, and then select Recordings.

If you're using Classic View, you can select the Recordings tab.

If you have sign-in issues, ensure that you have cookies are enabled in your browser.

Step 2 Locate the meeting recording that you want to share, and then select the corresponding icon.

The Share Recording dialog box opens.

Step 3 Enter an email address for each person with whom you want to share the recording.
Step 4 (Optional) Edit the message.
Step 5 (Optional) To copy the meeting URL, select the Copy URL icon.
Step 6 Select Save.

The system sends email to the specified users, to provide instructions to access the meeting recording.

The system administrator can restrict meeting sharing between CWMS users only.Note

Delete Meeting Recordings
Procedure

Step 1 Sign in to your Webex site, and then select Recordings.

If you're using Classic View, you can select the Recordings tab.

If you have sign-in issues, ensure that you have cookies are enabled in your browser.

Step 2 On the My Recorded Meetings page, locate the meeting recordings that you want to delete, and check the
corresponding check boxes.

To delete a single meeting, select the corresponding icon and then choose Delete.
Tip
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Step 3 Select Delete.
A confirmation dialog box appears.

Step 4 To delete the selected recordings, select Delete.
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C H A P T E R 11
Accessibility

• Use Audio CAPTCHA, on page 71
• Keyboard Shortcuts , on page 72
• Screen reader support, on page 75
• Low vision support, on page 75
• Accessibility Standards and Improvements, on page 75
• Manage Participants, on page 76
• Copy Text from the Chat Panel, on page 76
• Enter Text in an Input Box, on page 77
• Access the Meeting Controls Panel During Sharing, on page 77

Use Audio CAPTCHA
The CAPTCHA challenge-response test requires that you accurately enter the text that is presented into the
text box so that you can access your account. Webex presents you with this security measure when you fail
to sign in with the correct user credentials six times or when you choose to reset your password by selecting
the Forgot your password link. As an alternative to entering what you see in the image, you can enter the
text that you hear.

Audio CAPTCHA is not supported if your system is configured for SSO or LDAP authentication.Note

Procedure

Step 1 Navigate to the Hear an audio challenge link using the Tab or Shift+Tab keys and select Enter.
The text will be read to you.

Step 2 Enter the text that you hear into the text box and select Enter.
Step 3 To hear the text again, navigate to the Replay link using Shift+Tab and select Enter.

After entering the text correctly, you can proceed with signing in to Webex.

User Guide for Cisco Webex Meetings Server Release 4.0
71



Keyboard Shortcuts
New Meeting Controls Shortcuts

ToPress

Show or hide the meeting controlsCtrl + Shift + Q

Windows

ToPress

Show or hide the meeting controlsCtrl + Shift + Q

Cancel an action, or close an active window, menu, panel, or notification in full-screen sharing modeEsc

Access Webex Meetings HelpF1

Switch between the content area and the panels areaF6

• Switch between Panel View

• Switch between tabs in the following dialog boxes:

• Invite and Remind

• Preferences

• Meeting Options

• Participant Privileges

Ctrl + Tab

• Use right+click menus in the following panels and elements:

• Participants panel

• Chat panel

• Notes panel (Webex Meetings)

• Q & A panel (Webex Events)

• Closed Captions panel

• File Transfer window

• Shared whiteboard and file tabs

• Work with the participant list

• Copy text from the Chat panel

Shift + F10

During file sharing, use to return to the previous slidePgUp
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ToPress

During file sharing, use to advance to the next slidePgDn

Close any dialog boxAlt + F4

Copy text from the Chat panelCtrl + A

Show the Meeting Controls panel while sharingCtrl + Alt + Shift

Hide the Meeting controls, panels, and notifications while sharing (Webex Meetings)

Hide the Webex Events window (Webex Events)

Ctrl + Alt + Shift + H

Mute or unmute your audioCtrl + M

Allow all participants to shareCtrl + Alt +S

Assign privileges to participantsCtrl + K

Rotate the page left while sharing a fileCtrl + Shift + <

Rotate the page right while sharing a fileCtrl + Shift + >

Zoom in during sharingCtrl + +

Zoom out during sharingCtrl - -

Adjust the page size to fit the viewer during sharingCtrl + Shift + W

Synchronize the display of a shared page, slide, or whiteboard in all participant content viewers with the display in your viewerCtrl + Shift + Y

Share your screenCtrl + Alt + D

Share an applicationCtrl + Alt + A

Share a file or videoCtrl + Alt + O

Share a whiteboardCtrl + Alt + N

Browse to open and share a fileCtrl + O

Close a shared file or whiteboardCtrl + W

Undo the last actionCtrl + Z

Redo the last actionCtrl + Y

Mac

ToPress

Cancel an action, or close an active window, menu, panel, or notification in full-screen sharing modeEsc
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ToPress

Hide the Meeting controls, panels, and notifications while sharing (Webex Meetings)

Hide the Webex Events window (Webex Events)

Command + H

Lock the meeting or eventCommand + R

Mute allCommand + Shift + U

Assign privileges to participantsCommand + K

Rotate the page left while sharing a fileCommand + Shift + L

Rotate the page right while sharing a fileCommand + Shift + R

Zoom in during sharingCommand + >

Zoom out during sharingCommand + <

Adjust the page size to the available widthCommand + Option + 0

Adjust the page size to fit the viewer during sharingCommand + 0

Synchronize the display of a shared page, slide, or whiteboard in all participant content viewers with the display in your viewerCommand + Y

Share your screenOption + Command + K

Share a file or videoOption + Command + P

Share a web browserOption + Command + B

Share a whiteboardCommand + N

Browse to open and share a fileCommand + O

Close a shared file or whiteboardCommand + W

Add page while sharing a fileCommand + Shift + N

Undo the last actionCommand + Z

Redo the last actionCommand + Shift + Z

Open preferencesCommand + ,

End the meeting or eventCommand + L

Switch between the main video or sharing area and the panels, or move between the panels.F6 or Shift + F6

(WBS33.8 and later)
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ToPress

Switch between the visible buttons in the following panels:

• Participants panel

• Chat panel

• Notes panel (Webex Meetings)

• Closed Captions panel

• Multimedia Viewer panel

• Q & A panel (Webex Events)

• Polling panel

Tab or Shift + Tab

(WBS33.8 and later)

Screen reader support
We test Webex Meetings to ensure compatibility with the latest version of the Freedom Scientific JAWS
screen reader.

• All keyboard shortcuts for the Meetings desktop app work with screen readers.

• Screen readers can't read content from shared presentations, shared applications, and shared desktops.

You can manage which notifications you want to have your screen reader announce. For more information,
see Manage which notifications your screen reader announces.

Low vision support
Webex has limited support for low vision accessibility features that apply across our desktop and web apps.

• The application supports the high contrast scheme of the Windows OS.

• The application supports the zoom functionality of the OS.

Accessibility Standards and Improvements
Take a look at theWebexMeetings Voluntary Product Accessibility Templates to get details about accessibility
conformance in Webex Training.

For more info on the accessibility improvements being made toWebex services, see the CiscoWebexMeetings
Suite Accessibility Improvements.
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Manage Participants
The Participants panel provides a right-click menu that allows you to act upon a participant depending on
your role in the meeting:

• If you are the host or presenter, you can make someone else the presenter or mute another participant's
microphone if it is too noisy.

• If you are not the host or presenter, you can ask to become the presenter and mute your own microphone.

Procedure

Step 1 Press F6 on your keyboard to navigate from the contents area to the Participants panel.
Step 2 Navigate to the appropriate participant by using the up and down arrow keys.
Step 3 Select Shift+F10 to open the right-click menu on the specific participant.
Step 4 Use the up and down arrow keys to navigate between the available options.

Copy Text from the Chat Panel
The Chat panel provides a right-click menu that allows you to copy text from the Chat history area.

Before you begin

Make sure that you are in the correct portion of the meeting window by doing the following:

• Press F6 to move from the contents area to the panels area of the meeting window.

• Press Ctrl+Tab to navigate between panels until you are in the Chat panel.

• Press Tab until you are in the Chat history area.

Procedure

Step 1 With the focus on the Chat history area, select Shift+F10 to open the right-click menu.
Step 2 Use the up and down arrows to copy text or to select all text.

Alternatively, you can use Ctrl+A to select all the chat text.Tip

To select only a portion of the text, move your cursor with the arrow keys and then use Shift-[Arrow]
to highlight text.
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Enter Text in an Input Box
Note the following tips to enter text in an input box.

Procedure

Step 1 If the window includes questions, navigate between questions using the Tab key.
Step 2 If the window includes options, move between the options using the up and down arrow keys.
Step 3 Move the cursor to focus on the text input area and use the Spacebar or Enter key so you can type your

answer.
Step 4 Press Enter or Esc to finish editing.

Access the Meeting Controls Panel During Sharing
During sharing, theMeeting Controls panel is partially hidden at the top of your screen. Perform the following
steps to display the panel during sharing.

Procedure

Step 1 Enter Ctrl+Alt+Shift to show the panel.

After the panel appears, the initial focus is on the Participants icon.

Step 2 Do the following:
ToPress

Change focusTab

Activate a featureEnter

Return to the sharing area from the Meeting Controls panelAlt+Tab

• If you are sharing a file, select the Webex ball to return to the sharing area.

• If you are sharing an application, select the application to return focus to it.

• If you are sharing your desktop, select the application you want to share.

To switch from the Meeting Controls panel to another open panel, such as the Participants list,
press F6.

Note

User Guide for Cisco Webex Meetings Server Release 4.0
77

Accessibility
Enter Text in an Input Box



User Guide for Cisco Webex Meetings Server Release 4.0
78

Accessibility
Access the Meeting Controls Panel During Sharing



C H A P T E R 12
Troubleshooting

• 404 Page Not Found Error, on page 79
• Run a Problem Report from the Webex Meetings Desktop App, on page 79
• Troubleshoot Microsoft Outlook for Windows Integration, on page 80

404 Page Not Found Error
Problem You see a "404 page not found" error or you encounter connection problems when signing in or
joining meetings from your Microsoft Windows device.

Solution Use the following checklist to make sure that your device is set up to send and receive data:

• Check your network connection.

• Try using a different computer.

• Use a supported browser and ensure that Internet Explorer 11 is installed on your computer. You need
Internet Explorer 11 even if you don't intend to use IE for Cisco Webex Meetings.

• Turn on TLS 1.1, and SSL 1.2; go to Control Panel > Internet Options. Select the Advanced tab. A
list of check boxes appears. Scroll the list to locate the Security group. Under Security, ensure that the
TLS 1.1, and SSL 1.2 check boxes are checked.

Run a Problem Report from the Webex Meetings Desktop App
If you experience an issue with the Webex Meetings desktop app, you can run a problem report to collect
troubleshooting data. Cisco Technical Support can use this data to help identify and fix the problem. We
advise that you provide as much detail as possible, about the issue.

Procedure

Step 1 In the top right corner of the Cisco Webex Meetings desktop app, select .
Step 2 Select Send Problem Report.
Step 3 From the list, select a problem type.
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Step 4 Enter a description of the problem.
Step 5 (Optional) Uncheck the corresponding check box, if you don't want to include network information.

We recommend that you leave this box checked, unless your system administrator asks you to uncheck it.

Step 6 Generate the report:
Do thisTo

Select Save and navigate to the location where you
want to save the report. Select Save.

Create the report and save it locally.

Select Email. To send the mail, enter the email
address provided by your system administrator.

Create the report and automatically attach it to an
email.

Troubleshoot Microsoft Outlook for Windows Integration
Microsoft Outlook forWindows integration must be enabled in both the desktop app and inMicrosoft Outlook.
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Check Your Cisco Webex Meetings Desktop App Preferences

Procedure

Step 1 From the Windows Start menu, open the Cisco Webex Meetings desktop app.

Step 2 Select .
Step 3 From the drop-down list, select Preferences.
Step 4 Select Integrations.
Step 5 Ensure that the Microsoft Outlook check box is checked.

Check Your Microsoft Outlook Preferences

Procedure

Step 1 From Microsoft Outlook, go to File > Options > Add-ins.
Step 2 From the Manage drop-down list, select Disabled Items.
Step 3 Select Go.
Step 4 In the Disabled Items dialog box, select Add-in: WebExOI.Addin (ptolkadd.dll).
Step 5 Select Enable, and then select Close.
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